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 Using Autostar with an RFC

Autostar for Windows has a built-in feature that allows you to use an RFC (Related 
Finance Company) to automate the process of buying loans. This feature 
automatically accounts for loan discount transactions. With this feature, there’s no 
need for outside reporting and journal entries.

Before you use this feature, you must set up your finance company and your 
accounting links in Company Setup. If you have integrated accounting, the 
accounting for loan discounts is automatically done for you in the system.

In this document, you will learn to:

• Set up your related finance company

• Transfer loans to a related finance company

• Enter loans from an outside finance company

• View loan discount information

• Print reports to gather related finance company data
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Setting Up an RFC

Overview

Before you begin using a related finance company in Autostar for Windows, you 
must first set it up. This is similar to setting up your dealership in Autostar for 
Windows. To do this, you must go to Company Setup and enter default 
information related to your finance company. Once you set up these defaults, you 
can override the fields when you transfer notes to the finance company.

If you have multiple finance companies, you must use this procedure to set up each 
company you want to transfer notes to. For example, if you have a collections 
company, a legal company, or a write-off company that you transfer write-offs to, 
you must set up each of these separately in Company Setup.

Note: Every principal transaction impacts the loan discount. If you increase the 
principal after you purchase the loan with an account adjustment, there is 
no impact on the discount (because it was added after the purchase). If you 
decrease the principal with an accounting adjustment, the system treats it 
like a payment. For contracts other than daily simple, adjustments, 
payment reversals, and bad checks do not affect the principal balance.

Using a Related Finance Company with Integrated Accounting

If you have integrated accounting, you must set up your GL links before you 
transfer loans. To do this, you must go to the Program Setup 1 tab in Company 
Setup and edit the main ledger. You must set up the accounts to direct the GL 
account to take on the loss. If you don’t set up the links, the new GL link records 
will not be linked. You must link the new transaction types to GL accounts. These 
new links typically appear as FDISCXXX. The list below shows the transaction 
codes and their meaning:

• FDISCAMT - Unearned Discount - asset in receivable range - 1211

• FDISCAR - Due from RFC - 1990

• FDISCINC - Discount Income RFC - 4730

• FDISCLOSS - Loss On Sale of Loans - 7055

• FDISCPKS - RFC Pickups Due - 1990

• FDISCREB - Discount Write-off (Gain Loss on Repo - WO) - 7054

• FDUETO - Due to RAD (Related Auto Dealer) - 2410

• FTAXDUETO - Tax Due to RAD (Related Auto Dealer) - 2410

Steps for Setting Up an RFC

Perform the following steps to set up your related finance company.

1. From the Autostar for Windows Home Page, click on System Utilities.
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2. Click on Company Setup.

3. Click on the company you want to set up a related finance company for.

4. Click on the Edit Company button.

5. Click on the FC Options tab.

The FC Options screen appears.

6. In the Finance Company field, click in the box to activate the finance company 
screen.

7. In the Auto Fund Contracts in Transit field, do one of the following:

• Click in the box to check it if you want the system to automatically fund 
the Contracts in Transit when you transfer the note.

• Leave this box empty if you don’t want the system to automatically fund 
the Contracts in Transit when you transfer the note. When you select this 
option, you must print a check from AP when you transfer the note.

Note: If you automatically transfer loans, the system creates an 
intercompany payable on the finance company side, and it creates a 
receivable on the dealership side.

8. In the Transfer Remaining Pickups field, do one of the following:

• Click in the box to check it if you want to transfer the remaining pickups 
(deferred down) on the notes to the finance company.

• Leave this box empty if you don’t want to transfer the remaining pickups. 
If you select this option, the remaining pickups stay with the dealership that 
originated the loan.
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9. In the Carry Over Status/Tags field, do one of the following:

• Click in the box to check it if you want the system to pull all status and tags 
related to each contract over to the new record in the finance company. 
This means the system will pull over all tags on the vehicle, sale, and 
contract that were put on the contract before the transfer.

• Leave this box empty if you don’t want the system to pull existing status 
and tags to the new record in the finance company. This means no tags will 
appear on the contract when it is transferred to the finance company.

10. In the Default Lien Code field, enter the Lien Code you will use most often to 
transfer notes. The Lien Code will typically be your related finance company. 
You can override this default code when you transfer notes.

Note: When you transfer a note from the dealership to a related finance 
company, the lien code must be set up on the finance company side 
too. You can add a lien code on the fly if necessary. To do this, click 
on the Add button on the Lien Code screen.

11. In the Default Discount Percent field, enter the discount percentage you use 
most often when transferring loans to the related finance company. This 
percentage represents the anticipated loss (unearned discount). You can 
override this percentage when you transfer a loan if necessary.

12. Click on the Save Company button.
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Transferring Loans to a Related Finance Company
Once you have set up a related finance company, you can transfer loans from your 
dealership into the finance company. Complete the following steps to transfer 
loans to a finance company set up in Autostar for Windows.

1. Log in to Autostar in the finance company you want to transfer loans into. 
Make sure you log into the target company -- not the dealership where the loan 
currently exists.

Note: To change companies, click on the File menu in the upper left-hand 
corner of the Autostar for Windows screen. Then click on Change 
Company. Click on the company you want to change to, and then 
click on OK.

2. Click on Receivables.

3. Click on Import Contract Into Finance Company.

4. Click on the company you want to import loans from (e.g., the dealership).

5. Click on OK.

The Transfer screen appears. The top of the screen shows the source company 
(i.e., the company the loans are coming from) and the destination company 
(i.e., the company where the loans are going).

6. If you only want to transfer one loan, use the Select Contract field. In the 
Select Contract field, you can enter the contract number for the loan you want 
to transfer.



Transferring Loans to a Related Finance Company

6 Autostar for Windows User’s Manual 4/10/06

7. You can use the Lot Code field to scope and transfer loans for a specific lot. If 
you want to search for loans to transfer by lot, enter the starting lot number in 
the first Lot Code field. Enter the ending lot code in the second field. You can 
click on the lookup icon to search for lot codes if necessary.

8. You can use the Location Code field to transfer loans for a specific location. If 
you want to search for loans to transfer by location, enter the starting location 
number in the first Location Code field. Enter the ending location code in the 
second field. You can click on the lookup icon to search for location codes if 
necessary.

9. You can use the Vendor Code field to transfer loans for a specific vendor. If 
you want to search for loans to transfer by vendor, enter the starting vendor 
number in the first Vendor Code field. Enter the ending vendor code in the 
second field. You can click on the lookup icon to search for vendor codes if 
necessary.

10. You can use the Investor Code field to transfer loans for a specific investor. If 
you want to search for loans to transfer by investor, enter the starting investor 
number in the first Investor Code field. Enter the ending investor code in the 
second field. You can click on the lookup icon to search for investor codes if 
necessary.

11. You can use the Lien Holder Code field to transfer loans for a specific lien 
holder. If you want to search for loans to transfer by lien holder, enter the 
starting lien holder number in the first Lien Holder Code field. Enter the 
ending lien holder code in the second field. You can click on the lookup icon to 
search for lien holder codes if necessary.

12. You can use the Batch Code field to transfer loans for a specific batch. If you 
want to search for loans to transfer by batch code, enter the starting batch code 
number in the first Batch Code field. Enter the ending batch code in the second 
field. You can click on the lookup icon to search for batch codes if necessary. 
You can use this field to transfer all loans in a specified batch. For example, 
you can use this field to select to transfer all loans that are ready to be charged 
off.

13. You can use the Status Code field to transfer loans for a specific status. If you 
want to search for loans to transfer by status code, enter the starting status 
number in the first Status Code field. Enter the ending status code in the second 
field. You can click on the lookup icon to search for status codes if necessary.

14. In the Type of Sale field, click on one of the following:

• If you are transferring loans that were sold as a receivable sale, click on 
Receivable.

• If you are transferring loans that were sold as an outside finance sale, click 
on Outside Finance.
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15. In the Pickup Balance field, click on one of the following:

• If you want to transfer only loans that have an outstanding pickup balance, 
click on Outstanding.

• If you want to transfer only loans that have a paid off pickup balance, click 
on Paid Off.

• If you want to transfer loans with pickups and include all loans regardless 
of whether the pickup is paid off, click on Both.

16. In the PK Remain field, if you selected either Outstanding or Both in the 
Pickup Balance field, you can enter a pickup remaining amount to search for. 
Enter the starting value in the first field, and enter the ending value in the 
second field.

17. Outside Finance Loans Only: The Contracts-In-Transit field allows you to 
specify how you want to transfer CITs. Normally, CITs are funded when you 
transfer the loan. However, within Autostar you can fund a CIT before you 
transfer. You can use the options in this field to specify how you want to handle 
CITs. In the Contracts-In-Transit Status field, click on one of the following:

• If you want to transfer only loans that have a funded Contract-in-Transit, 
click on Funded.

• If you want to transfer only loans that have a Contract-in-Transit not 
funded, click on Not Funded.

• If you want to transfer all loans with a Contract-in-Transit, click on All 
CIT’s.

18. Outside Finance Loans Only: The Transfer Status field allows you to indicate 
whether you’re transferring new loans or loans that have already been 
transferred. Typically, you want to transfer loans that have not yet been 
transferred. However, this field can be used to reimport a contract that has 
already been imported. When you import a contract that has already been 
imported, the system makes a duplicate record, so you must delete the existing 
record. This feature is usually used to correct a mistake in a contract and 
reimport it. In the Transfer Status field, click on one of the following:

• If you want to transfer loans that have already been imported, click on 
Transferred.

• If you want to transfer only loans that have not yet been imported, click on 
Not Transferred.

• If you want to transfer all loans, including those that have been transferred 
and those that have not been transferred, click on All.

19. Receivable Loans Only: The Days Past Due field allows you to search for 
loans that are past due a specified number of days. If you want to search for 
loans based on days past due, enter the starting and ending number of days past 
due in this field.
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20. Receivable Loans Only: The Amount Past Due field allows you to search for 
loans that are past due a specified amount. If you want to search for loans 
based on amount past due, enter the starting and ending number of amount past 
due in this field.

21. Receivable Loans Only: The PK Past Due field allows you to search for loans 
that are past due a specified number of days on pickup payments. If you want 
to search for loans based on days past due for pickup payments, enter the 
starting and ending number of days past due in this field.

22. You can use the Date Sold field to search for loans sold on specific dates or 
timeframes. For example, you can use this field to transfer all loans sold for the 
current day or the current month. If you want to transfer loans for a specific 
date or date range, enter the starting date in the first Date Sold field. Then enter 
the ending date in the second date field. You can use the lookup icon to pull up 
a calendar and select a date.

23. In the On Bad Debt/Off Bad Debt field, you can search for loans that have been 
tagged with bad debt. Do one of the following:

• If you want to transfer loans with a bad debt tag, click on On Bad Debt. 

• If you want to transfer loans that aren’t tagged as bad debt, click on Off 
Bad Debt. 

• If you want to transfer all loans, regardless of whether they’re tagged with 
bad debt, click on Both.

24. The Out for Repo field allows you to indicate whether you want to transfer all 
loans or specify whether you want to transfer loans tagged for repo in the 
system. Do one of the following:

• If you want to transfer loans that are tagged for repo, click on Out for 
Repo. 

• If you want to transfer loans that are not tagged for repo, click on Not Out 
for Repo. 

• If you want to transfer all loans, regardless of whether they’re tagged for 
repo, click on Both.

25. Once you have selected the Scoping Options, you can select loans based on 
tags to select them for transfer. To do this, click on the Tags/Flags Scoping tab. 
From this screen, you can select loans with specific tags to include in the 
transfer. For example, you can use this field to select all loans tagged as 
bankruptcy.
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26. After you have selected all of your scoping options, click on the Show Filtered 
Results button.

The system generates a list of loans to be transferred that meet the criteria you 
selected. A sample of this screen is shown below.

27. From the Filter Results screen, you verify the loans you want to transfer. Do 
one of the following:

• Click on Select All to select all loans for transfer.

• Click on UnSelect All to de-select all of the loans on the screen.

• Click on a loan to select it for transfer.

• If you need to select just a few of the loans on the screen, click on the loans 
you want to select for transfer.

Note: You must click in the box next to the loan you want to select; you can’t 
click on the row where the name or contract number is.

Note: As you select loans to transfer, the system calculates the total loan cost and 
displays it at the bottom of the screen in the Selected Total field. You can 
use this field to guide you if you’re trying to transfer a specified dollar 
amount of loans.
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28. Once you have selected the loans you want to transfer (indicated by a 
checkmark), click on the Transfer button.

The system transfers the loans one at a time. As each loan is transferred, the 
system displays the Finance Company Transfer Options screen. A sample of 
this screen is shown below.

The following table describes each field on the screen and indicates whether you 
can change the data in a field.

Finance Company Transfer Options

Field name What do you enter in this field?

Top of screen The top of the screen shows the customer’s name and 
vehicle. This field is display only.

Source Company This field indicates the company the loan is being 
transferred from. This field is display only.

Destination Company This field indicates the company the loan is being 
transferred to. This field is display only.

Original Type of Sale This field shows the type of sale for the original 
contract (i.e., receivable or finance company). This 
field is display only.
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New Type of Sale This field shows the type of sale for the new contract. 
The new type of sale will always be receivable for all 
loans; the system transfers loans in as a receivable. 
This field is display only.

Original Contract # This field shows the original contract number. This 
field is display only.

New Contract # This field shows the new contract number for the 
transferred contract. This number is the same as the 
contract number from the original contract. You can 
enter a new number in this field if necessary.

Original Stock # This field shows the original stock number for the 
vehicle. This field is display only.

New Stock # This field shows the new stock number. This number 
is the same as the stock number from the original 
contract. You can change the stock number in this field 
if necessary.

Date Loan Purchased This field shows the date the loan was purchased. This 
field defaults to the current date, but you can change 
the date if necessary.

Date Last Paid This field shows the last date the customer made a 
payment on the contract. This field is display only.

Principal @ Purchase This field shows the principal amount of the loan 
when it was purchased. This field is display only.

Date Sold This field shows the date the original vehicle was sold. 
This field is display only.

Default Discount 
Percentage

This field shows the default discount percent for 
selling the loan. The number in this field represents 
the anticipated loss (unearned discount) on the loan. 
Typically, the discount is the same on all loans, but 
you can change this default at the time of transfer if 
necessary using the New Discount Percentage field. 
This default is based on the default discount 
percentage you set up in Company Set Up. This field 
is display only.

Finance Company Transfer Options

Field name What do you enter in this field?
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Include Pickups This field indicates if pickups are included. If the box 
is checked, then pickups are included. If the box is not 
checked, then pickups are not included.

New Discount 
Percentage

This field shows the revised discount percentage. This 
field automatically displays the default discount 
percentage entered in Company Setup, but you can 
enter a new discount percentage to be used when the 
loan is transferred.

Note: If you want to back into a specific discount 
percentage based on a dollar amount, you can 
enter the percentage here and the system will 
automatically calculate the amount.

Discount Amount This field shows the amount of the discount on the 
loan. This amount is calculated based on the discount 
percentage and the principal.

Note: If you want to back into a specific discount 
amount, you can enter the amount here and the 
system will automatically calculate the 
discount percentage.

Remaining Pickups This field shows the balance of any pickup payments 
still due on the contract. This field is display only.

Loan Cost This field shows the cost of the loan. This field is 
display only.

Total Loan Cost This field shows the total cost of the loan. This field is 
display only.

Fund Contract
Outside Finance Only

This field indicates whether you want to fund the 
contract when the loan is transferred. If this box is 
checked, then the system will fund the contract when 
the loan is transferred. If this field is empty, then the 
system will not fund the contract when the loan is 
transferred. If this is not an outside finance loan, this 
field doesn’t appear. 

Note: If this field is disabled, then the contract has 
already been funded, so you can’t select it for 
funding.

Finance Company Transfer Options

Field name What do you enter in this field?
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Carry Over Status/
Tags?

This field indicates whether status/tags in Autostar 
will be transferred with the loan. If this box is 
checked, then the system will carry over all status/tags 
with the loan. If this box is not checked, then the 
system will delete all status/tags when the loan is 
transferred.

Collector Pro Records 
Copied

This field only appears if you have Autostar Collector 
Pro installed. You can use this field to transfer 
Collector Pro records when you transfer the loan. 
Click on Yes if you want to copy the Collector Pro 
records when you transfer the loan. Click on No if you 
don’t want to copy the Collector Pro records when you 
transfer the loan.

Current/New Lot The Current Lot field shows the lot the loan is being 
transferred from. The New Lot field shows the lot the 
loan is being transferred to. You can change the New 
Lot code if necessary. If you enter a new lot code, the 
lot code must already exist in Autostar.

Current/New Location The Current Location field shows the location the loan 
is being transferred from. The New Location field 
shows the location the loan is being transferred to. You 
can change the New Location code if necessary. If you 
enter a new location, the location code must already 
exist in Autostar.

Current/New Investor The Current Investor field shows the investor the loan 
is being transferred from. The New Investor field 
shows the investor the loan is being transferred to. You 
can change the New Investor code if necessary. If you 
enter a new investor, the investor code must already 
exist in Autostar.

Current/New Status The Current Status field shows the status the loan is 
being transferred from. The New Status field shows 
the status the loan is being transferred to. You can 
change the New Status code if necessary. If you enter a 
new status, the status code must already exist in 
Autostar.

Finance Company Transfer Options

Field name What do you enter in this field?
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29. Verify all of the information on the Finance Company Transfer Options screen 
and make changes as necessary.

30. Once you have verified and/or changed all necessary information on the 
screen, click on Transfer when you’re ready to transfer the loan. Or, if you 
want to cancel the transfer, click on Cancel.

The system transfers the loan. The system displays a message when the transfer 
is complete. 

31. Click on OK.

The system then displays the next loan to be transferred. 

32. Complete Steps 29-31 for each loan you selected to transfer.

Once you have transferred all of the loans, the system tells you how many 
records have been transferred.

Current/New Batch The Current Batch field shows the batch the loan is 
being transferred from. The New Batch field shows 
the batch the loan is being transferred to. You can 
change the New Batch code if necessary. If you enter a 
new batch, the batch code must already exist in 
Autostar. 

Current/New Lien 
Holder

The Current Lien Holder field shows the lien holder 
the loan is being transferred from. The New Lien 
Holder field shows the lien holder the loan is being 
transferred to. You can change the New Lien Holder 
code if necessary. If you enter a new lien holder, the 
lien holder code must already exist in the system.

Current/New 
Insurance

The Current Insurance field shows the insurance the 
loan is being transferred from. The New Insurance 
field shows the insurance the loan is being transferred 
to. You can change the New Insurance code if 
necessary.

Revenue Code This field only appears if you set up Revenue Codes in 
Company Setup. This field shows what the revenue 
code is for the transferred loan in the source company. 
You can change the revenue code for the destination 
company if necessary by using the lookup icon.

Discount Loss 
Account

This field shows the account the discount loss will be 
recorded in.

Finance Company Transfer Options

Field name What do you enter in this field?
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33. Click on OK.

34. Click on Close.

Transferring a Receivable Deal from One Finance Company to Another 
Finance Company

If you have two finance companies set up within Autostar for Windows and you 
want to use one of them to charge off loans, you can use two different methods, 
depending on your situation. Refer to the following scenarios for more 
information.

• If you want to sell a loan from one finance company to another finance 
company, you can automatically pay the loan off and select the discount using 
the transfer procedure in this section. Simply follow the steps for transferring a 
loan and then click on the Pay Off Loan field on the Finance Company 
Transfer screen to activate the funding in the system.

• If you want to transfer a loan from one finance company to another finance 
company to keep track of the charge-off balance for potential post charge-off 
recovery efforts, then you don’t want the system to automatically pay off the 
loan. In this case, you should transfer the loan and leave the Pay Off Loan box 
on the Finance Company Transfer screen empty so the system doesn’t pay off 
the loan. Then, after you transfer the loan, you can go back into the first 
finance company and process the write off. Make sure you transfer the loan 
before you write it off. The system only allows you to transfer active loans.

 Using the Options Menu When Transferring Loans

While you are transferring loans, you can access the Options menu to complete 
specified tasks. This section provides instructions for using the Options menu.

Change Source Company
You can use the Options menu to change the source company. To do this, complete 
the following steps.

1. From the Finance Company Transfer Options screen, click on 

Options .

2. Click on Change Source Company.

3. Click on the company you want to change to.

4. Click on OK.
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Print a Ledger
You can print a ledger card when you’re in the Loan Transfer option. To do this, 
complete the following steps.

1. From the Finance Company Transfer Options screen, click on 

Options .

2. Click on Ledger.

The system displays a ledger card.

3. Click on the type of ledger card you want to print.

4. Click on Select.

The system displays the ledger card.

5. Click on the print icon to print the ledger card.

Print an F&I screen
You can print an F&I screen when you’re in the Loan Transfer option. To do this, 
complete the following steps.

1. From the Finance Company Transfer Options screen, click on 

Options .

2. Click on F&I Screen.

The system prints the F&I screen.

Sales Status screen
You can print a sales status screen when you’re in the Loan Transfer option. To do 
this, complete the following steps.

1. From the Finance Company Transfer Options screen, click on 

Options .

2. Click on Sales Status.

The system displays a sales status screen.

3. Click on Close.
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Entering Loans from an Outside Finance Company
If you buy a receivable sale from an unrelated dealership or finance company that 
is not set up in Autostar for Windows, you must use this procedure to enter the 
loans. When you enter a new receivable sale in a finance company, the system 
automatically recognizes the transaction as a discounted loan.

1. Log in to the finance company where the loan will reside.

2. Enter the sale using the standard sales process. On the F&I screen, you must 
enter the deal as a receivable.

3. Once you enter the sale information, click on Save as Sale.

The Save Sale Options screen appears, showing the purchase date, discount 
amount, discount percentage, and amount owed to dealer. The defaults appear 
in these fields, but you can change them before you save the sale.

4. Complete the Save Sale Options screen. You can change the Finance Company 
Options fields if necessary.

5. Click on OK to finish saving the sale.
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Viewing Discount Information After Transferring Loans
Once you have transferred loans to a related finance company, you can view the 
discount information from two screens in Autostar for Windows. You can access 
this information from the Take a Payment screen or the Maintain Past Sales screen. 
Depending on how the loan was entered, the screens look a little different. Refer to 
the sections below for instructions on viewing discount information. 

Note: The information on the Discount Status screen changes, depending on the 
status of the loan. Refer to the Discount Status Screen Examples on page 
page 19 to see the screen samples. 

Viewing Discount Information from Take a Payment

Perform the following steps to view discount information from the Take a Payment 
screen.

1. From the Autostar for Windows Home Page, click on Cash Receipts.

2. Click on Take a Payment.

3. Use the Search feature to pull up the contract you want to view.

4. Click on Options .

5. Click on Discount Info Screen.

The Discount Status screen appears. The information on the screen varies, 
depending on the type of deal.

Note: The fields on the screen are display only. You can only view this 
information. For an explanation of the fields on this screen, refer to 
“Finance Company Transfer Options” on page 10.

6. Click on Close to exit the screen.

7. Click on Close.

Viewing Discount Information from Maintain Past Sales

Perform the following steps to view discount information from the Maintain Past 
Sales screen.

1. From the Autostar for Windows Home Page, click on Sales.

2. Click on Maintain Past Sales.

3. Use the Search feature to pull up the contract you want to view.

4. Click on Options .
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5. Click on Discount Info Screen.

The Discount Status screen appears. The information on the screen varies, 
depending on the type of deal.

Note: The fields on the screen are display only. You can only view this 
information. For an explanation of the fields on this screen, refer to 
“Finance Company Transfer Options” on page 10.

6. Click on Close to exit the screen.

7. Click on Close.

Discount Status Screen Examples

This section shows the three versions of the Discount Status screen. The 
information on the screen varies, depending on the type of loan.

Entered Loan from F&I - The screen below shows the Discount Status screen 
when the contract is entered in the finance company from Sell a Vehicle.
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Transferred Loan - The screen below shows the Discount Status screen when the 
contract is transferred in from another company.

Amended Contract - The screen below shows the Discount Status screen when 
the original discounted contract is amended to a new discounted contract.
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Using Reports with a Related Finance Company
When you’re using a related finance company with Autostar for Windows, there 
are many reports that can help you analyze your data. This section lists some of the 
reports that include related finance company information. 

Note: To run these reports, you must be logged into the finance company.

Receivable Reports
The following reports in the Standard Receivable Reports contain data for related 
finance companies:

• Loan Purchase Report - This report shows the loans transferred for the 
specified date range selected. This report can be backdated.

• Detailed Accounts Receivable Report - This report shows active accounts 
and includes a column showing the Discount Balance. You should run this 
report monthly. This report cannot be backdated. 

• Payoff Report - This report shows the loans paid off for the specified date 
range and includes a column for the amount Due from RFC. You should run 
this report monthly. This report can be backdated. 

• Write-off Report - This report shows the loans written off for the specified 
date range and includes a column for Discount Loss. You should run this report 
monthly. This report can be backdated.

• Principle and Interest Report - This report shows the principal and interest 
collected for the specified date range and has a column for Discount Earned. 
This report can be backdated.

Cash Reports 
The following reports in the Standard Cash Reports contain data for related finance 
companies:

• Discount Earned Report - This report shows all loans purchased with the 
discount earned to date and for the period specified. 
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